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1 INTRODUCTION
This document presents the QFT Control Toolbox, or QFTCT, for Matlab. The
toolbox includes the latest quantitative robust control techniques within a userfriendly and interactive environment. The toolbox, developed by Prof. Mario
Garcia-Sanz, has been tested in numerous courses, universities, companies and
centers over the years. A complete study of the QFT robust control methodology
with the toolbox is presented in the book: Mario Garcia-Sanz, Robust Control
Engineering: practical QFT solutions, CRC Press, Taylor & Francis, 2017.[1]
The professional or full version of the toolbox can be requested at
http://codypower.com.[2] Additional information can be found at the sites:
http://crcpress.com and http://cesc.case.edu.

Fig. 1. 2-Degree-Of-Freedom (2DOF) feedback control system.
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Fig. 2. QFT design procedure and QFTCT windows.
The QFT Control Toolbox runs under Matlab and shows an architecture
based on seven principal windows, which are: W1- Plant Definition; W2Templates; W3- Control Specifications; W4- Bounds; W5- Controller Design; W6Prefilter Design; and W7- Analysis –see Fig.2 and also Fig.2.1.
The toolbox also includes a library of advanced functions in the Windows,
offers a user-friendly and interactive environment, and allows the user to easily rescale the problem from SISO (Single-Input-Single-Output) to MIMO (MultipleInput Multiple-Output) problems.
Following the QFT robust control methodology, the objective of the toolbox is
to design 2DOF (two degree of freedom) robust control systems, including plants
with model uncertainty and a multi-objective set of performance specifications –see
Fig. 1. The compensator G(s) and prefilter F(s) of the 2DOF control system are
to be designed to meet robust stability and performance specifications, including
reference tracking r(s), disturbance rejection d(s), de(s), di(s), do(s), signal noise
attenuation n(s) and control effort minimization u(s) specifications, while
reducing the complexity of the controllers (order) and quantifying the cost of
feedback (gain at each frequency and bandwidth).
Fig. 2 lists the steps involved in the QFT design procedure. Fig. 3
represents the toolbox flowchart of the QFT design procedure and Fig. 4
presents an overview of the QFT design process.
Required products:

Matlab 2015b (version 8.5) or later version.
Control System Toolbox 9.9 or later version.
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Platform:

PC, Windows 10, 8 or 7.

Installation:

To install the QFTCT, copy the files of the toolbox in a folder.
Then add that folder to the Matlab path:
file → set path → add folder → save → close.

Start:

To start a new session with the QFT Control Toolbox,
type “QFTCT” in the Matlab Command Window.
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Fig.3. QFT flowchart for a MISO control system.
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Fig. 4. An overview of the QFT design process.
2 QFT CONTROL TOOLBOX WINDOWS
This section describes the seven main windows of the QFT Control Toolbox
(QFTCT) for Matlab –see Fig.2 and also Fig.2.1.
2.1 GENERAL DESCRIPTION
The toolbox contains windows of the form shown in Fig. 5. As mentioned, they
fall into seven categories: W1: Plant Definition; W2: Templates; W3: Control
Specifications; W4: Bounds; W5: Controller Design; W6: Prefilter Design; W7:
Analysis. All the windows have a navigator panel at the top –see Fig. 6. This
allows the user to change the active window among the seven options. Not all
the windows are available from the beginning, as some windows have prerequisites that have to be met in order to activate them. The seven categories are
listed next, following the order that they have to be executed in the design
process:
1.

Plant definition: No pre-requisites.

2.

Templates: Needs Plant definition.

3.

Specifications: Needs Plant definition.

4.

Bounds: Needs Plant definition, Templates and Specifications.
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5.

Controller Design: Needs Plant definition, Templates, Specifications and
Bounds.

6.

Prefilter: Needs Plant definition, Templates, Specifications, Bounds and
Controller design. It is only for Reference tracking problems.

7.

Analysis: Needs Plant definition, Templates, Specifications, Bounds and
Controller design.

Fig. 5. Plant definition window.

Fig. 6. Window toolbar with the seven window categories.
(a)

(b)

Fig. 7. Common toolbars.
• Common Toolbars: All the windows of the toolbox have a toolbar –see
Fig. 7(a), which allows the user to create a new project, open an existing one
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or save the current project. The toolbar of the windows which have figures
(Templates, Bounds, Controller Design, Prefilter Design and Analysis) has
also controls to zoom in and out on the plots –see Fig. 7(b).
• Menu

Additionally, all the windows have the following two menus:

o File: Allows the user to create new projects, open existing projects, save the
current project and save the current project in a new file.
o Help: Provides information about the toolbox version, etc.
In addition,
o The windows that have figures include a menu item in the File menu that
allows the user to save the plot in a file with the format .emf, .bmp or .fig.
o Also, some windows have the following specific menu items:
 Templates. In the File menu, there is an option that allows the user to
export the nominal plant as a transfer function.
 Controller Design. In the File menu there are menu items that allows
the user to –see Fig. 8a:
 Load a controller from the hard disk (*.contr)
 Load a list of controllers from the hard disk (*.contrList)
 Save selected controller to the hard disk (*.contr).
 Save controller list to the hard disk (*.contrList)
 Export the selected controller as a transfer function to workspace.
 Save Figure to the hard disk (*.emf, *.bmp, or *.fig)
 Check nominal plant. It shows the selected nominal plant.
 Check stability. It checks the stability of the closed-loop system
with the nominal plant and the selected controller. It applies the
method presented in Chapter 3, Sec.3.4, and the algorithms
included in Appendix 3: The Nyquist Stability Criterion in the
Nichols Chart –see example in Fig. 8b.
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Fig. 8. (a) File Menu, Controller design window. (b) Check stability
The controller design window has also an Edit menu that allows the
user to:
 Undo changes
 Redo changes
 Set the frequency vector for L(s): minimum frequency and
maximum frequency (rad/s), and number of points.
 Prefilter Design Similarly, this window category has the following
menu items in the File menu:
 Load prefilter from the hard disk (*.prefltr)
 Load prefilter list from the hard disk (*.prefltrList)
 Save selected prefilter to the hard disk as (*.prefltr).
 Save prefilter list to the hard disk (*.prefltrList)
 Export the selected prefilter as a transfer function to the
workspace.
 Save Figure to the hard disk (*.emf, *.bmp, or *.fig)
2.2 PLANT DEFINITION WINDOW
In the Plant Definition window, see Fig. 9, the user can define the plant type,
model structure, parameters, uncertainty and frequencies of interest, either for
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the System plant P(s), or for additional plants like M(s) in Fig. 1 (add new plant
button). In the Plant type panel, the user can select the way to describe the plant
model, which can be: (1) Gain/Zero/Pole or ZPG transfer functions, (2)
Numerator/Denominator transfer functions, (3) State Space representation, (4) a
general array of transfer functions, (5) Experimental data.
• Gain/Zero/Pole Transfer Function. The model structure and its elements are
defined using the syntax listed in Table 1 and Eq.(1). In this option, the user
has to enter the information in the ZPG structure panel: number of real zeros,
complex zeros, real poles and complex poles –see Figs. 9 and 10. The user
also has to enter the value of the integrator/differentiator element: 0 if it is not
used, a positive integer for the number of differentiators and a negative integer
for the number of integrators. In addition, the user has to specify whether the
plant has time-delay (Yes/No). After all this information is entered, the user
clicks the Update button. Then, the Toolbox opens the ZPG parameters panel
and the user can write the expressions for the elements of the plant.

Fig. 9. Plant definition window.
Note that, at this point it is possible to introduce alpha-numeric
information with numbers, letters or expressions. If the user introduces
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expressions, the Toolbox identifies the letters in the expressions as parameters
with uncertainty, and automatically adds their names to the Parametric
uncertainty panel. In Figs. 9 and 10 a gain is introduced as “k/(a*b)’, a real
pole as “a”, and another real pole as “b" –see Eq. (2).
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Table 1. Gain/Zero/Pole/Delay element syntax.
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Fig. 10. Gain/Zero/Pole or ZPG structure and ZPG parameters panels.
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o Numerator/Denominator Transfer Function: The plants can also be
defined as a transfer function, with a numerator and a denominator as
Laplace polynomials –see Eq.(3). The first step consists in entering the
model structure: numerator and denominator polynomial orders –see Fig.
11 and Eq. (3). At this point the user can also specify whether there is or
there is not time delay in the plant. Then, after pressing the Update button,
the Toolbox updates the Numerator and Denominator panels, and the user
can enter the expressions for the coefficients of the polynomials and time
delay. Note that, at this point it is possible to introduce numbers or letters. If
the user introduces letters, the Toolbox identifies them as parameters with
uncertainty, and automatically adds their names to the parametric
uncertainty panel, which will be define afterwards. As an example, the
expression defined in Eq.(4) is introduced in Fig. 11.
P( s) =

Ncoef n s n + Ncoef n −1 s n −1 +  + Ncoef1 s + Ncoef indep −Ts
n( s )
e (3)
=
d ( s ) Dcoef m s m + Dcoef m −1 s m −1 +  + Dcoef1 s + Dcoefindep

Fig. 11. Numerator/denominator panels.
P( s ) =

Lambda
( M 1 M 2 ) s + 0 s + Lambda ( M 1 + M 2 ) s 2 + 0 s + 0
4

3

(4)

o State Space The plants can also be described with a state space
representation. In this case we enter the dimension (n, m, and v) of the
matrixes A (nxn), B (nxm), C (vxn) and D (vxm) –see Eq.(5) and Fig. 12.
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Also, we need to choose the input k (k ≤ m) and output q (q ≤ v) channels
for the yq(s)/uk(s) = Pqk(s), with P(s)v×m = [C(sI–A)–1B+D]v×m. As the
conversion from state space to transfer function typically involves some
round errors, we can introduce a tolerance error for the minreral(.) function
to remove the extra zeros and poles that could be added by Matlab in the
conversion. After clicking Create button, the Toolbox opens the State
Space matrices panel, and we can enter the expressions for the elements of
the four matrices and the input and output time delays. Note that, at this
point, we can introduce numbers or letters. If we introduce letters, the
Toolbox identifies them as parameters with uncertainty, and automatically
adds their names to the parametric uncertainty panel, which is defined later.

Fig. 12. State Space panel.
x = A x + B u

n×1

n× n

n× m

y = C x+ D u

v×1

v× n

(5)

v× m

o Load Transfer Function Array If the plant cannot be defined using the
three previous options, yet we can load an array of transfer functions
from a file. After uploading the file, we enter the row of the array that
represents the nominal plant.
Notice that this is a very powerful tool that can define any kind of plant,
with different structures and parametric and non-parametric uncertainty.
For the SystemPlant the technique is as follows: (1) Run first in Matlab a
m.file like the one described in Example 1; (2) Then go to the Workspace;
(3) Click on P with the right bottom and Save as PP.mat (or other name) in
the hard disk; (4) Then go to the Plant definition window; (5) Click “Load
transfer function array”; (6) Select Nominal plant (usually number 1); (7)
Click “Import.mat”; (8) Select in the hard disk PP.mat and click “Open”;
(9) Click “Commit”; (10) The plant will appear in the list of plants as
System Plant, P(s).
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For an additional plant: steps (1) to (6) are the same –now save as MM.mat,
for instance. Then (7) Click “Add new plant”; (8) Put a name in the “Plant
name” cell at the bottom (for example M); (9) Click “Import.mat”; (10)
Select in the hard disk MM.mat and click “Open”; (11) Click “Commit”;
(12) The plant will appear in the list of plants as M.
Example 1: mFile
c = 0;
for k = linspace(610,1050,3)
for a = linspace(1,15,15)
for b = linspace(150,170,2)
c = c+1;
P(1,1,c) = tf(k,[1 (a+b) a*b 0]);
M(1,1,c) = tf(k,[1/a 1]);
end
end
end

Notice also that we have three nested “for” loops in the above example
because there are three parameters with uncertainty: k∈[610,1050],
a∈[1,15], b∈[150,170]. We can also put another type of grid, different from
linespace, like logspace or others, or a mix. The definition of the plants in
this example is:
P(1,1,c)=tf(k,[1 (a+b) a*b 0]);
M(1,1,c)=tf(k,[1/a 1]);

which are: P(s) = k/[s3+(a+b)s2+ab s], and M(s) = k/[(s/a) + 1].
As we see, this option allows the user to include in these lines of the
algorithm any kind of structure or expression, even with different structures
(uncertainty in the structure) and with any parametric or non-parametric
uncertainty, interdependence in the uncertain parameters and many other
special features.
Finally, note that as this option is so open, it is important to make sure that
the numbers of the plants are consistent, i.e. the index “c” in P(1,1,c) and
M(1,1,c) is related to the same values of the parameters that P(1,1,c) and
M(1,1,c) share. This is easily done by defining P(1,1,c) and M(1,1,c) within
the same for-loop in the m.file, as shown in Example 1.
In case of a combination of “load transfer function array” plants with other
plants, like Gain/Zero/Pole or Numerator/Denominator or State-Space
plants, make sure that the definition of the parametric uncertainty
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(parameters and gridding) is consistent in all of them. Also select the same
gridding in the parametric uncertainty of the Analysis window.
o Load Experimental Data The user can also define the system by
uploading experimental data in a frequency-response-data vector. The
technique is as follows: (1) Prepare a frd (Frequency Response Data model)
system in Matlab: freq = vector of frequencies in rad/sec; resp = vector of
complex numbers with the response of the system at each frequency (a+jb),
experimentalData = frd(resp,freq). Note that the name of the frd structure
can be experimentalData or any other.
For example, in Matlab we can introduce the following arrays: freq =
logspace(–1,2,50); resp = 0.05*(freq).*exp(i*2*freq); experimentalData =
frd(resp,freq) –or a collection of real data in resp and freq; (2) Then go to
the Workspace; (3) Click on experimentalData with right bottom and save
as sys.mat (or other name) in the hard disk; (4) Then go to the Plant
definition window; (5) Click “Load experimental data”; (6) Select Nominal
plant (usually num.1); (7) Click “Import experimental...”; (8) Select in the
hard disk sys.mat and click “Open”; (9) Click “Commit”; (10) The plant
will appear in the list of plants as System Plant, P(s).
• Expressions and Parametric Uncertainty As seen, it is possible to introduce
alpha-numeric expressions. The toolbox automatically recognizes letters as
parameters with uncertainty. After entering the expressions of the plant, either
as parameters in the zpk model, or in the numerator/denominator model, or in the
state space matrices, and after pressing the Continue button, a new parametric
uncertainty panel appears to define the parametric uncertainty of the plant –see
Fig. 13. This panel displays the following information of each parameter:

Fig. 13. Parametric uncertainty panel.
o The name of the parameter.
o A button to open a window to modify the probability distribution of the
parameter.
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Fig. 14. Probability distribution: Uniform, Normal and Weibull cases.
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o The minimum and the maximum value of the parameter (given by its
probability distribution).
o Number of points in the grid for each parameter (two is the minimum
number, which means that there are only two points in the grid, the
minimum and the maximum), and its distribution (logarithmic or lineal).
o The nominal value of the parameter (it must be included in the minimum maximum range of the parameter).
• Probability distribution of the parameters In order to define the probability
distribution for the uncertainty of the parameters, the user needs to press the
Modify button in the Parametric uncertainty panel to open a new sub-window
–see Fig. 14. This sub-window has three probability distributions available:
Uniform, Normal and Weibull. After selecting the distribution and entering its
parameters, a graphical representation of the distribution is plotted. Also, the
user can define the percentage to be reached. This percentage is applied to the
distribution, and the resulting values will be the minimum and the maximum
values of the parameter.
• System plant frequency vector The user has also to enter a vector with the
frequencies of interest of the plant –see for example Figs. 5 and 9. The
textbox accepts an array of numbers or a Matlab command that produces the
array of numbers, e.g., logspace (–2,3,100). Note that it is very important to
define this vector correctly, populating the vector with an enough number of
points in the frequency regions where there are resonances or quick changes
in magnitude or phase, as well as selecting properly the lowest and the highest
value of frequency.
2.3 TEMPLATES WINDOW
A template is the representation of the frequency response of the plants,
including the uncertainty, in the Nichols Chart at a particular frequency. There is
a specific window to define the templates –see Fig. 15.
•

Number of Template Points The number of points of the templates
depends on three parameters: template type, parametric uncertainty and
template contour. If the template is too sparse, then it might be not accurate
enough to represent the plant. On the contrary, if the template has too many
points, the number of calculations to generate the bounds in the next step
might be too high.

•

Template type The user can select four different template types, ordered
from sparse to dense: “Vertex”, “Edges”, “Faces” and “All points”. Fig. 16
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shows different template types for a plant which has three uncertain
parameters The filled circle in each of the templates denotes the nominal
plant.
•

Grid of the Parametric Uncertainty Variables The more points are
considered –see Fig. 13, the denser the templates are (unless the template
type is “Vertex”).

•

Template Contour In the lower part of the window there is a slider which
can be used to adjust the contour of the templates. When the slider is moved
to the right the inner points of the template become sparser. Fig. 17 shows
the template of a plant that has initially 1000 points (a), and the template of
the same plant after its contour has been adjusted (b).

Fig. 15. Template definition window.
• Plant Frequencies There is a template for each frequency of interest. The
user can add and remove frequencies using the Templates window (or the
Plant definition window as well).
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o Add Frequency Frequencies can be added using two different methods:


By entering the value of the new frequency in the textbox beside
“Manual” and pressing the Add button –see Fig. 15.



By using the slider –see the Add frequency panel in Fig. 15. When
the user clicks the Initialize button in the Add frequency panel, the
slider is enabled and the user can pre-visualize the position and
shape of the new template. The user can then use the slider to
enter the value of the new frequency. Then, by clicking the Fix
button, the new frequency is added to the list.

Vertex (8 points)

Faces (178 points)

Edges (64 points)

All (250 points)

Fig. 16. Template Types.
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o Remove Frequency To remove a frequency, the user has to click the
Initialize button in the Remove frequency panel. A list box appears, and
enables the user to select the frequency to be removed. The points markers
of the template associated with the frequency are indicated by ‘x’ instead of
‘o’. To remove the selected frequency, click “Remove”.
o Frequency Vector The user can use the Frequency vector panel (see Fig.
15) to change the visibility of the templates associated with the frequencies.
If the user double clicks on a number of the frequency list that represents a
template, the visibility of the template is switched (on/off). The user can
also use the Show all and Hide all buttons to show all the templates or to
hide them all, respectively.

(a)

(b)

Fig. 17. Template without contour adjustment [1000 points, (a)],
and with contour adjustment with the slider [51 points, (b)].
• Modify parametric uncertainty The user can modify the parametric
uncertainty by pressing the Modify uncertainty button –see Fig. 15. Then, a
new sub-window allows the user to modify the parametric uncertainty in the
same way as in the plant definition window –see Fig. 18. Also, using this
sub-window the user can see how the changes in the parametric uncertainty
are applied in real time to the templates window.
• Export Nominal Plant The templates window has a menu item that allows
the user to export the nominal plant as a transfer function. The nominal plant
is saved in the current directory as a *.mat file. Afterwards, the user can load
that file to the Matlab´s Workspace (load *.mat) to use it.
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Fig. 18. Parameter uncertainty window.
2.4 SPECIFICATIONS WINDOW
This window allows the user to introduce robust stability and performance
control specifications –see Fig. 19. The Choose specification type panel includes
seven groups of specifications. The first six options are the classical
specifications that correspond to Eqs. (9) to (14), and the last one is a general
specification that corresponds to Eq. (15). This last option is able to generate the
first five specifications and many other possibilities, including additional
transfer functions like M(s) in Fig. 1 and others. See Table 2 for more details.
• Predefined Specifications: [see Eqs. (9) to (14)]. The user can add
specifications for any transfer function extracted from Fig.1, as defined in
Eqs. (6) to (8). The most common control specifications, including stability,
disturbance rejection, reference tracking and control effort attenuation are
defined as T1, T2, … T6 in the Choose specification type panel. They
correspond to Eqs. (9) to (14), or Eqs.(2.35) to (2.40) in Chapter 2 –see also
Fig.19.

1
PGH
PG
( PG d e + P di + d o + M d ) −
n (6)
Fr+
1 + PGH
1 + PGH
1 + PGH
GH
G
G
n (7)
Fr+
u=
( d e − H P di − H d o − H M d ) −
1 + PGH
1 + PGH
1 + PGH
1
H
H
( PG d e − P di − d o − M d ) −
n (8)
e=
Fr−
1 + PGH
1 + PGH
1 + PGH
y=

• User-defined specifications: [see Eq. (15)]. All the predefined specifications,
except the reference tracking, can be expressed using the Tk Defined by user
specifications. Moreover, the option Tk opens the door to a wide variety of
control specifications. It corresponds to Eqs. (15) and (2.41). By selecting the
functions A, B, C and D, we can define any one of the previous specifications
(T1 to T5) and also other cases that include additional plants introduced in the
Plant definition window. In this way, we can define general disturbance
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rejection specifications, cascade control loops, asymmetric topologies,
specifications involving Smith Predictor blocks, MIMO equivalent plants,
DPS plants, etc. For instance, see the code for Example 4.4 in Appendix 4, or
for Example 5.5 in Appendix 5, or for Example 8.1 (Secs.8-9 and 8-10) in
Appendix 8.

Fig. 19. Specifications window.

Table 2. Control system specifications.
T1: Stability specs

T1 ( jω ) =

(9)

P( jω ) G ( jω )
≤ δ1 (ω ) = Ws , ω ∈ Ω1
1 + P ( jω ) G ( j ω )

where T1 ( jω ) =

y ( jω )
F ( jω ) r ( jω )

T2: Complementary sensitivity specs
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P ( jω ) G ( jω )
≤ δ 2 (ω ) , ω ∈ Ω 2
1 + P ( jω ) G ( jω )

where T2 ( jω ) =

y ( jω )
y ( jω )
u ( jω )
y ( jω )
e ( jω )
=
=
=
=
F ( jω ) r ( jω )
n ( jω )
d i ( jω )
d e ( jω )
d e ( jω )

T3: Sensitivity or Disturbances at plant output specs

T3 ( jω ) =

(11)

1
≤ δ 3 (ω ), ω ∈ Ω 3
1 + P ( jω ) G ( jω )

where T3 ( jω ) =

y ( jω )
e ( jω )
e ( jω )
e ( jω )
=
=
=
d o ( jω )
d o ( jω )
F ( jω ) r ( jω )
n ( jω )

T4: Disturbances at plant input specs

T4 ( jω ) =

(12)

P ( jω )
≤ δ 4 (ω ), ω ∈ Ω 4
1 + P ( jω ) G ( jω )

where T4 ( jω ) =

y ( jω )
e ( jω )
=
d i ( jω )
d i ( jω )

T5: Control effort reduction specs

T5 ( jω ) =

(13)

G ( jω )
≤ δ 5 (ω ), ω ∈ Ω 5
1 + P ( jω ) G ( jω )

where T5 ( jω ) =

u ( jω )
u ( jω )
u ( jω )
u ( jω )
=
=
=
d e ( jω )
d o ( jω )
n ( jω )
F ( jω ) r ( jω )

T6: Reference tracking specs

δ 6 _lo (ω ) < T6 ( jω ) =

(14)

y ( jω )
P ( jω ) G ( jω )
= F ( jω )
≤ δ 6 _up (ω ),
r ( jω )
1 + P ( jω ) G ( jω )

ω ∈ Ω6
Pd ( jω )G ( jω ) 1 + Pe ( jω )G ( jω )
Pe ( jω )G ( jω ) 1 + Pd ( jω )G ( jω )

≤ δ 6 (ω ) =

δ 6 _ up (ω )
, ω ∈ Ω6
δ 6 _ lo (ω )

Tk: General specs

(15)
A( jω ) + B( jω )G ( jω )
≤ δ k (ω ), ω ∈ Ω k
C ( jω ) + D( jω )G ( jω )

•

Eq. (9) [T1(jω)] defines the robust closed-loop stability specification.
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•

Eq. (10) [T2(jω)] defines complementary sensitivity, robust sensor noise
attenuation, robust control effort limitation from the plant input disturbance,
and robust rejection of disturbances at the input of the controller.

•

Eq. (11) [T3(jω)] defines the sensitivity, robust rejection of disturbances at
the output of the plant, and robust sensor noise attenuation.

•

Eq. (12) [T4(jω)] defines robust rejection of disturbances at the input of the
plant.

•

Eq. (13) [T5(jω)] defines robust control effort limitation from disturbances
at the controller input, plant output, sensor noise, and filtered reference
signal.

•

Eq. (14) [T6(jω)] defines the robust reference tracking specification.

•

Eq. (15) [Tk(jω)] defines any specification from type T2(j ω) to T5(jω), and
many other options in general, where A(j ω), B(j ω), C(j ω), and D(j ω) can be
defined by the user, from several options like 0, 1, P(jω), or any other plant
introduced in the Plant definition window, as for example M(j ω) to define
the specification |M(j ω)/[1+P(jω)G(j ω)]|.

The value of δi( ω) denotes the upper limit of the magnitude of the objective (the
specification) at every frequency of interest. Each specification can be defined
for a different set of frequencies ωi, always a sub-set of the original set of
frequencies of interest –see also Fig.(2.14).
• Defining a Specification The user has to enter the value of the performance
specification δi( ω) [δ6_up( ω) and δ6_lo(ω) in the reference tracking case]. The
method to enter the value of δi(ω) depends on the type of specification being
defined, so that:
o Robust stability specs [see Table 2, Eq. (9) and Fig. 20]. δ1(ω) is a constant
(Ws). The user can enter directly the value of δ1( ω) = Ws for the stability
specification. Ws is the closed-loop constant magnitude M circle (in
magnitude) in the Nichols chart. In this case, the gain and phase margins are
calculated automatically. If the user introduces the phase margin PM, then
Ws and GM are calculated automatically. The following equations are used
in the calculations:

1 
 , in dB
(16)
Gain Margin: GM = 20 log10 1 +

 Ws 

 0.5 
 180 
 , in deg
Phase margin: PM = 180 − 2 
 acos

 π 
 Ws 
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Closed-loop M circle: Ws =

23

0.5
  π  180 − PM
cos 

2
  180 





, in magnitude

(18)

Fig. 20. Defining stability specifications, either as Ws, or as GM and PM.

Fig. 21. Defining δ2( ω) = 0.9, as a constant. Similar for δi( ω), i = 2,3,4,5.
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Fig. 22. Defining δi(ω), i = 2,3,4,5 as a transfer function. Click: Transfer
function in Fig.21. Then: δ2(s) = (2.719 s + 32.63) / (s2 + 6.061 s + 32.63).
o Robust performance specs. [see Table 2, Eqs. (10) to (13) and Figs. 21 and
22]. δi(ω), i = 2,3,4,5 can be defined as a constant (see Fig. 21), a vector of
constants of the same length as the specification frequency vector, or as
transfer function (zero/pole/gain or num/den, see Fig. 22). In this case, if
δi(ω) is a transfer function, its Bode diagram is also displayed in the
Specification window (similar to Fig. 19).
o Robust reference tracking specs. [see Table 2, Eq. (14) and Figs. 23 and
24]. In this case the user has to define δ6_up(ω) and δ6_lo(ω) (see Fig. 23).
Again, both values can be defined as constants, as a vector of constants or
as transfer functions. Besides, if this type of specification is selected, there
are more plots available: the step time-response of δ6_up( ω) and δ6_lo(ω), the
Bode diagram of δ6_up( ω)–δ6_lo(ω), see Fig. 24, and the Bode diagram of
δ6_up(ω) and δ6_lo( ω), see Fig. 19. The reference tracking specification type
button (Fig. 20) is active only if the plant has model uncertainty.
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Fig. 23. Defining δ6_up( ω) and δ6_lo(ω) specifications.

Fig. 24. Bode diagram of the difference δ6_up( ω)–δ6_lo( ω).

Fig. 25. Defining “Defined by user” specs., Eq. (15), having for example M(j ω)
from the Plant definition window, and doing |M(j ω)/[1+P(j ω)G(jω)]|.
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o Defined by user specs. [see Table 2, Eq. (15)]. In this case the user not only
has to enter δk(ω), but also A(jω), B(jω), C(j ω), and D(jω), for a
specification |[A(j ω)+B(j ω)G(jω)]/[C(j ω)+D(j ω)G(j ω)]|≤δk(ω). They can be
constants (0 or 1), the system plant P(j ω) or other auxiliary plants like
M(j ω), defined in the Plant Definition window. Notice that G(jω) is the
feedback controller.
• Frequency Vector The user can define a different frequency vector for each
specification. These vectors must be a subset of the initial frequency vector of
the system plant.
• Specification Addition The user can define new specifications by selecting
them in the Choose specification type panel –see Fig. 19 or 25. Then, once the
parameters of the specification are entered, the user clicks the Commit button
to finally add the specification.
• Specification Edition To edit a specification, the user has to select it in the
Defined specifications panel. Then, the data of the specification are displayed
in the center panel of the window. Once the specification is edited, the user
clicks the Update button to apply the changes.
• Specification Removal To remove a specification the user selects it in the
Defined specifications panel and click the Delete button.
2.5 BOUNDS WINDOW
Given the plant templates and the control specifications, QFT converts the
closed-loop magnitude specifications [T1(j ω) to Tk(j ω)] into magnitude and
phase constraints for a nominal open-loop function L0(j ω) = P0(jω)G(j ω). These
constraints are called QFT bounds –see Fig. 26. After the design of the
controller G(s) (next section), the nominal open-loop function L0(j ω) must
remain above the solid-line bounds and below the dashed-line bounds at each
specific frequency of interest, to meet the specifications.
The Bounds window (see Fig. 26) shows the QFT bounds of each
specification defined in the Specification window, as well as the Union of all the
bounds and the Intersection (worst case scenario) of all the bounds.
By clicking “Show all” or “Hide all”, the toolbox plots all the bounds or
hides all of them. By double clicking on its corresponding frequency, the bound
of that frequency is shown or hidden.
The user can define the minimum, maximum and step value of the phase
vector of the bounds with the Edit phase vector submenu in the Edit menu.
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Fig. 26. Bounds window.
2.6 CONTROLLER DESIGN WINDOW
Once the user has introduced the information of the plant and the control
specifications, and once the templates and bounds have been calculated, the next
step involves the design (loop-shaping) of the feedback controller G(s), so that
the nominal open-loop transfer function L0(s) = P0(s)G(s) meets the bounds –see
Fig. 27. Generally speaking, the loop-shaping, or G(s) design, requires to change
the gain and add poles and zeros, either real or complex, until the nominal loop
L0(s) lies above the solid-line bounds and below the dashed-line bounds at each
frequency of interest.
• Controller Management
o Controller addition There are two ways of add a new controller:
 To create the new controller from scratch, the user has to enter the
name of the controller and press the Add controller button. If there is
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not any other controller defined with that name, the new controller
appears in the list of added controllers.
 If the user wants to add a new controller based of the dynamics of an
existing controller, the user has to select it from the “Added
controllers" list and press the Copy button. The user has then to enter
the name of the new controller in the emerging sub-window.
o Controller removal To remove a controller, the user has to select it
from the list of “Added controllers” and press the Delete button.

Fig. 27. Controller Design window.
• Controller dynamics When defining a controller, the user can work with the
dynamics listed in the Table 12, according to Eq. (19).
n

L0 ( s ) = P0 ( s )

∏ [G ( s)]
i

i =0
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Table 3. Controller elements, Gi(s).
Gain

±k

Integrators,
Differentiators

Real zero

s
+1
zi

Real pole

s2

Complex
zero

ωn 2

+

2ζs

ωn

+ 1 , (ζ < 1)

Complex pole

1
sn

, sn

1
s
+1
pj
s

2

ωn 2

+

1
2ζs

ωn

, (ζ < 1)
+1

Lead/Lag
network

s

 + 1
 zi

 s


+ 1
 pj




Notch filter


 2
 s + 2ζ 1s + 1

ω 2 ω
n

 n

 s2
2
s
ζ

+ 2 + 1

ω 2 ω
n

 n

P.I.
controller


1 

K p 1 +

 Ti s 

P.D.
controller




Td s 

K p 1 +
 Td s + 1 


N



P.I.D. controller




Td s 
1

K p 1 +
+
 Ti s Td s + 1 


N



To add a new dynamic element Gi(s) in the controller G(s) = Π Gi(s), the
user has to press the Add dynamic button. The dynamic is added with its
predefined values. In the lower left corner of the window there is a panel which
shows information about the selected dynamic. The information displayed
depends on the type of the element, as shown in Figs. 28 to 31.
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Fig. 28. Windows for gain, real zero, real pole and integrator/differentiator.

Fig. 29. Window for complex zero and complex pole.

Fig. 30. Window for Lead/Lag element and Notch filter.
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Fig. 31. Window for PI, PD and PID controllers.
o Dynamic edition:
All the dynamics can be edited by entering their new values in the textboxes
that appear in the Edit selected controller dynamic panel (see Fig. 27), as
shown in Figs. 28 to 31.
o Dynamic removal
The user can remove an element of the controller by selecting it in the
Controller dynamics panel and pressing the Delete selected dynamic button.
When the user edits some dynamics of the controller, the updated
L0(j ω) is shown in the Nichols plot as a red dashed line, meaning that the
changes are provisional. To commit the changes, the user has to press the
Commit button. Then the red dotted line is drawn as a solid black line. To
discard the changes, the user has to press the Cancel button.
Figs. 32 illustrate an example of the graphic dynamic edition.
Fig.32(a) shows the Controller design window and two details of the
secondary window. To meet the bounds, the user changes the position of
the selected real pole, from p = 0.1 to p = 300. Fig.32(b) shows how all the
plots have been updated accordingly.
o Change History Each time the user adds, edits or removes a dynamic
element, the change is added to the Controller history panel (see Fig. 33).
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The user can undo and redo changes by selecting different entries in the
Controller history panel, by pressing Ctrl+x and Ctrl+y respectively, and by
using the Edit menu as well.

Fig. 32. An example of the graphic dynamic edition. From (a) pole pj = 0.1 to
(b) pole pj = 300. NC: Original L0(s) in black solid line. New L0(s) in red dashed
line. Secondary window: plant poles (x) and zeros (o) in black, controller poles
(x) and zeros (o): blue = original, or red, green = new.
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o Secondary Window The user can open a secondary window with the
following plots (see Fig. 34): Bode diagram of G(s), Bode diagram of L0(s),
root locus of L0(s) and unit step response of L0(s)/[1+L0(s)]. The secondary
window can be resized, and the changes made to the selected controller are
applied in real time to all the diagrams.

Fig. 33. Controller history panel.

Fig. 34. Panel to open de secondary window.

Fig. 35. Pointer info panel.


Pointer Information In the upper right corner of the Controller design
window there is a panel that shows information about the pointer –see
Fig. 35. If the pointer is over the Nichols plot, the panel shows
information about where the pointer is (magnitude and phase). If the
pointer is placed over the L0(j ω) line, the panel also includes the
frequency ω associated with that point.
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2.7 PREFILTER DESIGN WINDOW
If the plant has model uncertainty and the control problem requires reference
tracking specifications, then the Prefilter design window is active after the
design of the G(s) controller.
Fig. 36 shows the Prefilter design window, with the following plots: the
upper and lower reference tracking specifications [δ6_up( ω), δ6_lo(ω), dashed blue
lines], see Eq. (14) and Fig. 23, and the maximum and minimum cases of
L0(s)F(s)/[1+L0(s)] over the plant uncertainty (dashed black lines).
The design of the prefilter calculates automatically the worst upper and
lower closed-loop response cases of L0(s)F(s)/[1+L0(s)] over the plant
uncertainty. These cases should be between the upper and lower reference
tracking functions to meet the specifications. The Prefilter Design window is
similar to the Controller Design window. The way in which the prefilters are
added, edited and removed is the same.

Fig. 36. Prefilter Design window.
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The Prefilter Design window has an additional List of controllers panel
which allows the user to select among the feedback controllers G(s) designed in
the previous window.
2.8 ANALYSIS WINDOW
Once the user finishes the controller (and prefilter) design, the Analysis window
is active. The analysis is performed in both, the frequency domain and the time
domain. The window analyses the controller G(s), and prefilter F(s) in the
tracking case, in the worst case scenario over the plant uncertainty.
• The window allows the user to perform two types of analysis:
Frequency Domain Analysis Select the specification of interest in the
Specification panel, and the Frequency domain option in the Analysis type
panel. The Toolbox shows the Bode diagram for the specification and the
control system with the selected controller and prefilter (if any). The
dashed line represents the desired specification δi( ω) and the solid line the
worst case of the control system over the plant uncertainty at each
frequency –see Fig. 37 for the analysis of the stability specification in the
frequency domain. Notice that the solid line is not a transfer function, but
the worst case among all the transfer functions over the plant uncertainty
at every frequency.

Fig. 37. Analysis window: Frequency domain specifications.
Time Domain Analysis After selecting the specification, the input (step
or impulse), the controller G(s) and prefilter F(s), and clicking the time
domain simulation button, the toolbox analyses the time response of the
control system with every the plant defined in the Parametric uncertainty
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panel. Fig. 38 shows two cases: (a) y(t) response for L0(s)F(s)/[1+L0(s)]
with r(s) = unitary step; and (b) y(t) response for P0(s)/[1+L0(s)] with d(s)
= unitary impulse. The number of plants analyzed (number of lines
plotted) depends on the values introduced in the Parametric uncertainty
panel.

Fig. 38. Analysis window: Time domain specifications.
• Controller/Prefilter Combinations The user can select any combination of
controllers (from the Controller List panel) and prefilters (from the Prefilter
List panel) previously defined (if any).
• Frequency Vector Panel for the analysis The Analysis frequency vector
panel allows the user to enter the frequency vector to be used in the frequency
domain analysis. If there are not enough points in the frequency vector, the
resulting analysis may not be accurate enough –see Fig. 39.
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Fig. 39. Stability analysis: (a) with not enough points in the frequency vector,
(b) with a more populated grid.
• Parametric Uncertainty Panel As it was explained, this panel allows the
user to modify the grid of the parametric uncertainty variables. Again, if too
few points are selected, the analysis may not be accurate enough. On the other
hand, if too many points are selected, the analysis may be slow. This panel
allows the user to analyze the system in both, (1) the points previously defined
in the plant definition window (with the parametric uncertainty panel), and
(2) in new points of uncertainty, defined now in the analysis window with the
parametric uncertainty panel.
If the responses for all the selected plants satisfy the desired control
performance specifications at both frequency and time domains, then the design
is completed.
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